# Table of Contents

Preface ................................................................................................................................................. v
1. General information .......................................................................................................................... v
   1.1. Purpose ........................................................................................................................................ v
   1.2. Audience ....................................................................................................................................... v
   1.3. Typographical conventions ........................................................................................................ v
2. Feedback and Support ......................................................................................................................... v

Chapter 1. Prior to installing the Talend products .............................................................................. 1
   1.1. Installation requirements ............................................................................................................... 2
   1.2. Studio specific prerequisites ......................................................................................................... 3
   1.3. Compatible Platforms and Java environments ............................................................................. 3

Chapter 2. Installing Talend Studio for the first time ........................................................................ 5
   2.1. Downloading and installing Talend Studio ................................................................................... 6
   2.2. Installing the XULRunner package (for Linux users) ................................................................... 6
   2.3. Installing the MDM server .......................................................................................................... 7
      2.3.1. Installing MDM modules using the jar file .............................................................................. 7
   2.4. Launching Talend Studio ............................................................................................................. 11
      2.4.1. Launching the Studio ........................................................................................................... 11
   2.5. Installing external modules .......................................................................................................... 12
      2.5.1. Identify required external modules ....................................................................................... 12
      2.5.2. Install external modules ...................................................................................................... 15

Chapter 3. Upgrading your Talend products ....................................................................................... 17
   3.1. Backing up the environment .......................................................................................................... 18
   3.2. Upgrading the Talend projects in the Studio .............................................................................. 18

Appendix A. Supported Third-Party System/Database/Business Application Versions ........... 19
   A.1. Supported systems, databases and business applications by Talend components ....................... 20
Preface

1. General information

1.1. Purpose

This Installation Guide explains how to install configure and upgrade the Talend modules and related applications. For detailed explanation on how to use and fine-tune the Talend applications, please refer to the appropriate Administrator or User Guides of the Talend solutions.

Information presented in this document applies to Talend products 6.1.2.

1.2. Audience

This guide is for administrators and users of the Talend products.

💡 The layout of GUI screens provided in this document may vary slightly from your actual GUI.

1.3. Typographical conventions

This guide uses the following typographical conventions:

- text in **bold**: window and dialog box buttons and fields, keyboard keys, menus, and menu and options,
- text in `[bold]`: window, wizard, and dialog box titles,
- text in `courier`: system parameters typed in by the user,
- text in `italics`: file, schema, column, row, and variable names,

- The 🕵️‍♂️ icon indicates an item that provides additional information about an important point. It is also used to add comments related to a table or a figure,

- The ⚠️ icon indicates a message that gives information about the execution requirements or recommendation type. It is also used to refer to situations or information the end-user needs to be aware of or pay special attention to.

- **Any command is highlighted with a grey background or code typeface.**

2. Feedback and Support

Your feedback is valuable. Do not hesitate to give your input, make suggestions or requests regarding this documentation or product and find support from the Talend team, on Talend’s Forum website at:
http://talendforge.org/forum
Chapter 1. Prior to installing the Talend products

This chapter provides useful information on software and hardware prerequisites you should be aware of, prior to starting the installation of the Talend modules.

In the following documentation:

- recommended: designates an environment recommended by Talend based on our experiences and customer usage;
- supported: designates a supported environment for use with the listed component or service;
- supported with limitations: designates an environment that is supported by Talend but with certain conditions explained in notes.
1.1. Installation requirements

To make the most out of the Talend products, please consider the following hardware and software requirements.

Memory usage heavily depends on the size and nature of your Talend projects. However, in summary, if your Jobs include many transformation components, you should consider upgrading the total amount of memory allocated to your servers, based on the following recommendations.

Table 1.1. Memory usage

<table>
<thead>
<tr>
<th>Product</th>
<th>Client/Server</th>
<th>Recommended alloc. memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Studio</td>
<td>Client</td>
<td>3GB minimum, 4 GB recommended</td>
</tr>
</tbody>
</table>

The same requirements also apply for disk usage. It also depends on your projects but can be summarized as:

Table 1.2. Disk usage

<table>
<thead>
<tr>
<th>Product</th>
<th>Client/Server</th>
<th>Required disk space for installation</th>
<th>Required disk space for use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Studio</td>
<td>Client</td>
<td>3GB</td>
<td>3+ GB</td>
</tr>
</tbody>
</table>

Ulimit settings on Unix systems

- To make the most out of the Talend server modules and improve performance on Unix systems, you should set the limit of system resources (ulimit) to unlimited.

Environment variable configuration: on Windows

Prior to installing your Talend solutions, you have to set the JAVA_HOME Environment variable:

- Define your JAVA_HOME environment variable so that they point to the JRE directory.

  Example: if the JRE path is C:\Java\JRE\x.x.x\bin, you must set the JAVA_HOME environment variable to point to: C:\Java\JRE\x.x.x.

  It is highly recommended that the full path to the server installation directory is as short as possible and does not contain any space character. If you already have a suitable JRE installed in a path with a space, you simply need to put quotes around the path when setting the values for the environment variable.

Environment variable configuration: on Linux

Prior to installing your Talend solutions, you have to set the JAVA_HOME and Path environment variables:

1. Find the JRE home dir and export it in the JAVA_HOME environment variable.

   Example:

   ```
   export JAVA_HOME=/usr/lib/jvm/jre1.8.0_65
   export PATH=$JAVA_HOME/bin:$PATH
   ```

2. Add these lines at the end of the global profiles in the /etc/profile file or in the user profiles in the ~/.profile file.

   Note that after changing one of these files you have to log on again.

For more information on how to set the JAVA_HOME variables on Unix and Windows systems, see the online Oracle documentation.
1.2. Studio specific prerequisites

Some bulk components, like Oracle, Sybase, Informix or Ingres, require database client software to run properly.

Install the following utilities according to your needs:

• OracleBulkExec uses the `sqlldr` external utility. This utility is available in Oracle clients that must be installed on the computer.

• Informix uses the `dbload` external utility.

• Ingres uses the `sql` external utility.

• Sybase uses the `bcp.exe` external utility. This utility is asked for in the Sybase bulk components' Basic Settings view. For more information, see `tSybaseBulkExec`, `tSybaseOutputBulk` and `tSybaseOutputBulkExec` components on the appropriate Talend Components Reference Guide.

1.3. Compatible Platforms and Java environments

Please refer to the following grids for a summary of supported OS and Java Runtime environments.

### Table 1.3. Java environments

<table>
<thead>
<tr>
<th>Support type</th>
<th>Vendor</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recommended</td>
<td>Oracle Java</td>
<td>8</td>
</tr>
</tbody>
</table>

For more information on Java specificities (version, OS compatibility), please see the Knowledge Base articles on Talend Help Center.

### Table 1.4. Talend Studio

<table>
<thead>
<tr>
<th>Support type</th>
<th>OS</th>
<th>Version</th>
<th>Processor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recommended</td>
<td>Unix</td>
<td>Linux Ubuntu</td>
<td>12.04</td>
</tr>
<tr>
<td></td>
<td>Windows</td>
<td>Microsoft Windows Professional</td>
<td>7</td>
</tr>
<tr>
<td>Supported</td>
<td>Unix</td>
<td>Linux Ubuntu</td>
<td>16.04</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Linux Ubuntu</td>
<td>14.04</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Redhat Linux Enterprise Server Edition/ CentOS</td>
<td>7.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Redhat Linux Enterprise Server Edition/ CentOS</td>
<td>6.5/6.6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SUSE SLES</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td>Windows</td>
<td>Microsoft Windows</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microsoft Windows</td>
<td>8.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microsoft Windows</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>Mac OS</td>
<td>OS X</td>
<td>El Capitan/10.11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OS X</td>
<td>Yosemite/10.10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OS X</td>
<td>Mavericks/10.9</td>
</tr>
<tr>
<td>Deprecated</td>
<td>Mac OS</td>
<td>OS X</td>
<td>Mountain Lion/10.8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OS X</td>
<td>Lion/10.7</td>
</tr>
</tbody>
</table>
Chapter 2. Installing Talend Studio for the first time

We strongly encourage you to read the Prior to installing the Talend products before starting this chapter.

This chapter details the procedures required to install Talend Studio.
2.1. Downloading and installing Talend Studio

Download

1. Download the product on this page.

   Note that the .zip file contains binaries for ALL platforms (Linux/Unix, Windows and MacOS).

2. Once the download is complete, extract the archive file on your hard drive.

   It is recommended to avoid spaces and long names in the target installation directory path.

Configure the memory settings

- If you want to tune the memory allocation for your JVM, you only need to edit the .ini file corresponding to your executable file. For example:

- For Talend Studio on 32bit-Windows, edit the file: TOS_DI-win32-x86.ini;
- For Talend Studio on Linux, edit the file: TOS_DI-linux-gtk-x86.ini.

The default values are:

-vmargs -Xms40m -Xmx500m -XX:MaxMetaspaceSize=128m

If you only have 512MB of memory on your computer, you can specify the memory allocation as following, for example:

-vmargs -Xms40m -Xmx256m -XX:MaxMetaspaceSize=64m

Learn more on http://www.oracle.com/technetwork/java/hotspotfaq-138619.html

2.2. Installing the XULRunner package (for Linux users)

On Linux, the XULRunner package is required to run the Studio.

The XULRunner package version that is recommended is XULRunner v1.9.2.28.

The supported versions are v1.8.x - 1.9.x and v3.6.x.

1. Download XULRunner version from this location.

2. Unpack the archive file in the same directory where you unpacked the studio archive, but do not unpack it within the Studio folder.

3. Add the following line at the end of the Studio .ini file that corresponds to your Linux architecture:

-Dorg.eclipse.swt.browser.XULRunnerPath="/usr/lib/xulrunner"

where "/usr/lib/xulrunner" is the xulrunner installation path.

For example, if you have unpacked the Studio in a directory under your user home directory /home/<user>/Talend/, you need to add the following to the .ini file:
2.3. Installing the MDM server

You can install the MDM server using a graphical installer.

In the following documentation, `<TomcatPath>` designates the path where Tomcat has been installed, and `<$INSTALLDIR>` specifies the path where the MDM server has been installed.

2.3.1. Installing MDM modules using the jar file

The jar file allows you to launch a cross-platform MDM-dedicated graphical installer to install the Tomcat server (optional) and deploy the MDM Server in simple click-next steps.

Using the jar file provided by Talend, you can install the MDM modules in three different modes:

- A cross-platform graphical installer to help you install Tomcat (optional) and deploy the MDM Server in simple click-next steps. For further information, see Installing in GUI mode.

- Otherwise, open your command-line and use the command: `java -jar <jar name>.jar -console`, and then follow the instructions to complete the installation of the MDM server and the stewardship console. For further information, see Installing in Command/Console mode.

- You can also generate a script through selecting the corresponding button in the last panel of the graphical installer. Script generation requires running the graphical installer, but the generated script can be used from the command-line. The installation can be run by passing the installation script as a parameter to the installer. For further information, see Installing in Silent mode.

The sections below explain in detail these three installation modes.

2.3.1.1. Installing in GUI mode

Talend Studio and Talend MDM Web User Interface require that you install an MDM server.

**Prerequisite(s):**

- JRE 1.8.0 or higher must be installed. You should also make sure that the `JAVA_HOME` environment variable is set to point to the JRE directory.
  
  For example, if the path is `C:\Java\JREx.x.x\bin`, you must set the `JAVA_HOME` environment variable to point to: `C:\Java\JREx.x.x`.

- Make sure you have read and write access to the folder where the MDM server will be installed (`C:\Talend` for example).

- (Linux only) A Windows Manager must be installed.

  - It is highly recommended that the full path to the server installation directory is as short as possible and does not contain any space character.

  - If you already have a suitable JRE installed in a path with a space, you need to put quotes around the path when setting the values for the environmental variable.

To install the MDM server using a `.jar` file, follow the procedures below.
Installing MDM modules using the jar file

**Launching the installer**

1. Right-click the *jar* file and select with your Java runtime environment to run the installer.
   A language selection pop-up opens.

2. From the language selection pop-up, select an installation language from the list and click **OK** to close the pop-up and proceed to the next step.

3. On the **Talend MDM** welcome page, click **Next** to proceed to the next step.

4. Read the license agreement and select the accept option. Click **Next** to proceed to the next step.

5. Read the license information and click **Next** to proceed to the next step.

**Selecting the packs**

1. Select the check boxes of the packs you want to install, and then click **Next** to proceed to the next step.

   If you have a Tomcat application server already installed on your machine and you do not want to re-install it, clear the **Tomcat** check box.

   The check boxes of required packs are already selected and unavailable: **Talend MDM Application**.

2. Once you have made your choice, click **Next** to proceed to the next step.

3. Browse to where you want to install the selected packs, and then click **Next** to proceed to the next step.

   If you cleared the Tomcat check box, you also need to specify the directory where Tomcat is installed.

   ![Specify your installation directories](image)

   A message is displayed to inform you that the target directory will be created.

4. Click **OK** to close the message and proceed to the next step.

**Selecting the MDM server ports configuration**

- From the **Ports** list, select the set of ports to be used by the MDM server, and then click **Next**. By default, **ports-1 (8180)** is selected.
Selecting and configuring the database

1. Select the type of database you want to use from the Database Type drop-down list and then click Next to proceed to the next step.

2. If you selected an RDBMS database, configure its connection parameters:

   When H2 Embedded is selected:

   1. Choose the database generation policy. You have a choice between creating a database for each container, or using a single database for all containers.

   2. Enter the User name and Password to use for connecting to the database.

   ![Configure connection to RDBMS](image)

   3. Click Next to proceed to the next step.

Specifying the location for the fulltext search index directory

1. Browse to the directory where you want to store the database fulltext search index.
2. Click **Next** to proceed to the next step.

A message is displayed to inform you that the target directory will be created.

The installation settings you defined in the previous steps will be displayed in the wizard.

1. Click **Next** to proceed to the next step and start the installation.

Two progress bars indicate how much of the installation has been completed.

2. When the progress bars indicate the end of the installation, click **Next** to have a confirmation message that the installation is completed successfully.

   Click **Generate an automatic installation script** to generate a script for MDM server installation.

   You can use this script to install the MDM server on any platform without using the graphical installer.

3. Click **Done** to close the installer.

   The MDM server is installed.

To run the MDM server, execute `startup.bat` (Windows) or `startup.sh` (Linux) in the `<TomcatPath>/bin` folder.

To shut the MDM server down, press **Ctrl + C** in the console window, or run `bin/shutdown.bat` or `bin/shutdown.sh`.

### 2.3.1.2. Installing in Command/Console mode

You can install the MDM server in a non-GUI mode using the command-line.

**Prerequisite(s):**

- JRE 1.8.0 or higher must be installed. You should also make sure that the `JAVA_HOME` environment variable is set to point to the JRE directory.

  For example, if the path is `C:\Java\JRE\x.x\bin`, you must set the `JAVA_HOME` environment variable to point to: `C:\Java\JRE\x.x`.

- Make sure you have read and write access to the folder where the MDM server will be installed (`C:\Talend` for example).

- (Only Linux) A windows manager must be installed.

  - It is highly recommended that the full path to the server installation directory is as short as possible and does not contain any space character.
To use the command-line capabilities to install the MDM server:

1. Unzip the .jar server file provided by Talend.
2. Open your console server depending on the platform you have.
3. Enter the below command, and then press the Enter key on your keyboard to launch the installation procedure through this text-only interface.
   ```
   java -jar <jar name>.jar -console
   ```
4. Follow the instructions to install the MDM server.

### 2.3.1.3. Installing in Silent mode

When installing the MDM server using the graphical installer as outlined in Installing in GUI mode, you can generate an installation script at the last step in the graphical installer. This script is an XML file that contains the installation configuration settings.

You can later use this generated script from your console to install the MDM server. The installation can be run by passing the installation script as a parameter to the installer as the following:

```
java -jar <jar name>.jar -<script name>
```

### 2.4. Launching Talend Studio

The following procedures describe how to launch the Studio, how to log in the Studio and how to create your first project.

#### 2.4.1. Launching the Studio

**Launch the Studio**

- On Windows, double-click the executable file to launch Talend Studio.
- On Unix-like systems, add execution rights on the desired TOS_DI-* binary before launching it.
  
  On a standard Linux distribution, the command is:
  
  ```
  $ chmod +x TOS_DI-linux-gtk-x86.sh
  $ ./TOS_DI-linux-gtk-x86.sh
  ```

- On Mac OS X, launch the following file:
  
  `TOS_DI-macosx-cocoa.app/Contents/MacOS/TOS_DI-macosx-cocoa`

**Public license**

- First screen is a license screen. In the [License] window that appears, read and accept the terms of the license agreement to proceed to the next step.
Login and first project

1. As first time user, you need to set up a new project or you can also import a Demo project which gathers numerous job samples.

Select what you want to do next:

- Create a new project: [Local Project]
- Import a demo project
- Import an existing project

2. To import a demo project, select **Import a demo project** and click **Finish**. In the dialog box that opens, select the project you want to import.

   To create a new project, select **Create a new project** and enter the name of your project in the corresponding field.

3. Click **Finish** when complete, to open a welcome window and launch the Studio.

2.5. Installing external modules

*Talend Studio* requires specific third-party Java libraries or database drivers (*jar* files) to be installed to connect to sources and targets. Those libraries or drivers, known as external modules, can be required by some of *Talend* components or by some connection wizards or by both. Due to license restrictions, *Talend* may not be able to ship certain external modules within *Talend Studio*.

2.5.1. Identify required external modules

When you launch *Talend Studio* or select **Help > Install Additional Packages** in the *Talend Studio* menu, if any external modules are found missing for any features, the [Additional Talend packages] wizard opens, showing the **Optional** and **Required third-party libraries** check boxes. Make sure these check boxes are selected and click **Finish** to open the [Download external modules] dialog box, which lists all the available external modules, displays the license terms under which the external modules are provided, and lets you install all the modules at a single click. For more information, see Install external modules.

On your design workspace, if a component requires the installation of external modules before it can work properly, a red error indicator appears on the component. With your mouse pointer over the error indicator, you can see a tooltip message showing which external modules are required for that component to work.

When you open the **Basic settings** or **Advanced settings** view of a component for which one or more external modules are required, you will see a piece of highlighted information about external modules, followed by an **Install** button. Clicking the **Install** button opens a wizard that will show you the external modules to be installed.
The **Modules** view lists all the modules required to use the components embedded in the Studio, including those Java libraries and drivers that you must install to get the relevant components or Metadata connection working.

If the **Modules** view is not shown under your design workspace, go to **Window > Show View... > Talend** and then select **Modules** from the list.

The table below describes the information presented in the **Modules** view.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>points out if a module is installed or not installed on your system.</td>
</tr>
<tr>
<td></td>
<td>The <img src="icon" alt="Warning" /> icon indicates that the module is not necessarily required for the corresponding component or Metadata connection listed in the <strong>Context</strong> column.</td>
</tr>
<tr>
<td></td>
<td>The <img src="icon" alt="Stop" /> icon indicates that the module is absolutely required for the corresponding component or Metadata connection.</td>
</tr>
<tr>
<td>Context</td>
<td>lists the name of <strong>Talend</strong> component or Metadata connection using the module. If this column is empty, the module is then required for the general use of <strong>Talend Studio</strong>.</td>
</tr>
<tr>
<td></td>
<td><img src="icon" alt="Library" /> This column lists any external libraries added to the routines you create and save in the Studio library folder. For more information, see the <strong>Talend Studio User Guide</strong>.</td>
</tr>
<tr>
<td>Module</td>
<td>lists the module exact name.</td>
</tr>
<tr>
<td>Description</td>
<td>explains why the module/library is required.</td>
</tr>
<tr>
<td>Required</td>
<td>the selected check box indicates that the module is required.</td>
</tr>
</tbody>
</table>

In addition to the **Modules** view, the Studio provides a mechanism that enables you to easily identify, download and install most of the required third-party modules from the **Talend** website and directs you to valid websites for the rest.

A Jar installation wizard appears whenever any required external module is found missing for any feature in the Studio, including when you:

- drop a component from the **Palette** if one or more external modules required for that component to work are missing in the Studio, or

- click the **Check** button in a Metadata connection setup wizard in **Talend Studio** if one or more external modules required for the connection are missing in the Studio, or

- click the **Guess schema** button in the **Component** view of a component if one or more external modules required for that component to work are missing in the Studio,

- click **Install** on the top of the **Basic settings** or **Advanced settings** view of a component for which one or more required external modules are missing,
• run a Job that involves components or Metadata connections for which one or more required external modules are missing, or

• click the button in the Modules view.

When you click this button, the wizard that appears will list all the required external modules that are not integrated in the Studio.

The table below describes the information presented in the wizard.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jar</td>
<td>The file name of the external module.</td>
</tr>
<tr>
<td>Module</td>
<td>A short description about the nature of the module.</td>
</tr>
<tr>
<td>Required by component</td>
<td>Lists the components that require the external module.</td>
</tr>
<tr>
<td>Required</td>
<td>The selected check box indicates that the module is required.</td>
</tr>
<tr>
<td>License</td>
<td>The license under which the module is provided.</td>
</tr>
<tr>
<td>More information</td>
<td>Provides the URL of the valid website where you can find more information about this module and download the module manually.</td>
</tr>
<tr>
<td>Action</td>
<td>Click to open the [Download external modules] dialog box to download and install the module, which is available on the Talend website; Open in browser: Click the link to open the valid website to download the module, which is not available on the Talend website, and then click the jar button to import the downloaded module into your studio; You need to find and download the module yourself and click the jar button to import it into your studio.</td>
</tr>
<tr>
<td>Do not show again</td>
<td>Select to prevent the wizard from appearing again unless you click the button in the Modules tab view. This check box box shows only when you drop a component, set up a connection, or guess the schema of a database, that requires an external module, or click the Install button on the Component tab of a component that requires an external module.</td>
</tr>
<tr>
<td>Click here to obtain more information about external modules</td>
<td>Click to go to Talend online documentation on installing third-party modules.</td>
</tr>
</tbody>
</table>

This wizard lists the external modules to be installed, the licenses under which they are provided, and the URLs of the valid websites where they are downloadable, and allows you to download and install automatically all the
Install external modules

modules available on the Talend website and download those not available on the Talend website by following the links provided in the Action column and then install them into your Studio manually.

When you drop a component, set up a connection, or guess the schema of a database, that requires an external module for which neither the Jar file nor its download URL information is available on the Talend website, the Jar installation wizard does not appear, but the Error Log view will present an error message informing you that the download URL for that module is not available. You can try to find and download it by yourself, and then install it manually into the Studio.

To show the Error Log view on the tab system, go to Window > Show views, then expand the General node and select Error Log.

2.5.2. Install external modules

To download and install modules in the Studio

To download and install external modules automatically, do the following:

If you are working behind a network proxy, make sure you have correctly set up your proxy before you can download and install external modules in your Studio. To access the proxy settings, select Window > Preferences from the menu to open the [Preferences] window, then expand the General node and click Network Connections.

1. In the Jar installation wizard, click the Download and Install button to install a particular module, or click the Download and install all modules available button to install all the available modules, or select Help > Install Additional Packages from the menu to open the [Additional Talend Packages] wizard. From this wizard, make sure the Optional and Required third-party libraries check boxes are selected and click Finish. The [Download external modules] dialog box opens.

This [Additional Talend Packages] wizard appears automatically when you launch Talend Studio if any additional packages, including external modules, need to be installed for any features to function in the Studio.
2. To download and install the external module(s) provided under a particular license, select that license from the Licenses pane, review the license terms, select the I accept the terms of the license agreement option, and click Finish to start the download and installation process.

   To download and install all external modules provided under all the listed licenses, click the Accept all button to start the download and installation process.

   Upon installation of the chosen external module or modules, a dialog box appears to notify you about the number of modules successfully installed and/or about the modules failed to install, if any.

   To install manually an external module you already have in your local file system, do the following:

   1. Click the button in the upper right corner of the Modules view or in Jar installation wizard to browse your local file system.

      If the Modules view is not shown under your design workspace, go to Window > Show View... > Talend and then select Modules from the list.

   2. In the [Open] dialog box of your file system, browse to the module you want to install, double-click the .jar file, or select it and then click Open to install it.

      The dialog box closes and the selected module is installed in the library folder of the current Studio.

      You can now use the component or Metadata connection dependent on this module in any of your Job designs.

To install modules downloaded from external websites

Some modules are not available on the Talend website but can be downloaded directly from external websites. Once downloaded, these modules must be placed in specific folders.

- For the studio, the downloaded modules must be placed in the following folder:

  <StudioPath>/configuration/m2
Chapter 3. Upgrading your Talend products

This chapter describes the various operations required to migrate version of the Talend solutions.

We assume that you have installed and configured these solutions as described in the Installing Talend Studio for the first time.

The migration and upgrade process includes the following mandatory steps:

💡 These steps usually need to be completed in the following order.

1. Backing up the environment, see the Backing up the environment.

2. Upgrading the Talend projects in the Studio, see the Upgrading the Talend projects in the Studio.
3.1. Backing up the environment

Before you start migrating your Talend solutions, make sure your environment is correctly backed up.

The environment backup process includes the following mandatory steps:

These steps usually need to be completed in the following order.

1. Saving the local projects, see Saving the local projects.

Saving the local projects

1. Launch the Studio.

2. Click the icon and export your local projects to an archive file.

3.2. Upgrading the Talend projects in the Studio

Importing your local projects

1. Launch the new Studio you have just installed.

2. In the login window, select Import, then import the archive file containing your local projects.

The local projects are displayed in the Project list and appear on the Studio Repository view.

For more information on how to export local projects to an archive file, see Saving the local projects.
Appendix A. Supported Third-Party System/Database/Business Application Versions

This document provides the information about the versions of the systems or databases or business applications supported by Talend Studio.
A.1. Supported systems, databases and business applications by Talend components

The access to these systems, databases and business applications varies depending on the Studio you are using.

<table>
<thead>
<tr>
<th>Systems/Databases</th>
<th>Versions</th>
<th>OS</th>
<th>Available with...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alfresco</td>
<td>2.1</td>
<td>N/A¹</td>
<td>All Talend products</td>
</tr>
<tr>
<td>Amazon Redshift</td>
<td>Initial release of Amazon Redshift</td>
<td>N/A¹</td>
<td>All Talend products</td>
</tr>
<tr>
<td>AS/400</td>
<td>V5R2 to V5R4</td>
<td>N/A¹</td>
<td>All Talend products</td>
</tr>
<tr>
<td></td>
<td>V5R3 to V6R1</td>
<td>N/A¹</td>
<td>All Talend products</td>
</tr>
<tr>
<td></td>
<td>V6R1 to V7R2</td>
<td>N/A¹</td>
<td>All Talend products</td>
</tr>
<tr>
<td>Access²</td>
<td>2003</td>
<td>Windows</td>
<td>Talend products with Data Integration (DI), Master Data Management (MDM), Enterprise Service Bus (ESB) or Big Data</td>
</tr>
<tr>
<td></td>
<td>2007</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bonita</td>
<td>5.2.3</td>
<td>N/A¹</td>
<td>All Talend products</td>
</tr>
<tr>
<td></td>
<td>5.3.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5.6.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5.10.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>6.5.2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cassandra</td>
<td>2.0</td>
<td>Windows + Linux</td>
<td>Talend products with Big Data</td>
</tr>
<tr>
<td></td>
<td>(Deprecated versions: 1.1.2/1.2.2)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CouchBase</td>
<td>2.0</td>
<td>Windows</td>
<td>Talend products with Big Data</td>
</tr>
<tr>
<td>CouchDB</td>
<td>1.0.2</td>
<td>Windows</td>
<td>Talend products with Big Data</td>
</tr>
<tr>
<td>DB Generic</td>
<td>ODBC</td>
<td>Windows</td>
<td>All Talend products</td>
</tr>
<tr>
<td>DB2</td>
<td>10.5</td>
<td>Windows + Linux</td>
<td>Talend components with all products.</td>
</tr>
<tr>
<td></td>
<td>10.1</td>
<td></td>
<td>Talend products with MDM or ESB.</td>
</tr>
<tr>
<td>EXASolution</td>
<td>4</td>
<td>Windows</td>
<td>Talend products with DI, MDM, ESB or Big Data</td>
</tr>
<tr>
<td>FireBird</td>
<td>2.1</td>
<td>Windows + Linux</td>
<td>Talend products with DI, MDM, ESB or Big Data</td>
</tr>
<tr>
<td>Greenplum</td>
<td>4.2.1.0</td>
<td>Windows (client only) + Linux</td>
<td>Talend products with DI, MDM, ESB or Big Data</td>
</tr>
<tr>
<td>HSQLDb</td>
<td>1.8.0</td>
<td>N/A¹</td>
<td>Talend products with DI, MDM, ESB or Big Data</td>
</tr>
<tr>
<td>Informix</td>
<td>11.50</td>
<td>Windows + Linux</td>
<td>All Talend products</td>
</tr>
<tr>
<td>Ingres</td>
<td>9.2</td>
<td>Windows + Linux</td>
<td>All Talend products</td>
</tr>
<tr>
<td>Interbase</td>
<td>7 and above</td>
<td>N/A¹</td>
<td>Talend products with DI, MDM, ESB or Big Data</td>
</tr>
<tr>
<td>JavaDB</td>
<td>6</td>
<td>Windows + Linux</td>
<td>Talend products with DI, MDM, ESB or Big Data</td>
</tr>
<tr>
<td>LDAP</td>
<td>No version limitation</td>
<td>Windows + Linux</td>
<td>All Talend products</td>
</tr>
<tr>
<td>Microsoft AX</td>
<td>Dynamics AX 4.0</td>
<td>N/A¹</td>
<td>All Talend products</td>
</tr>
<tr>
<td></td>
<td>Dynamics AX 2012</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft CRM</td>
<td>2011</td>
<td>N/A¹</td>
<td>All Talend products</td>
</tr>
<tr>
<td></td>
<td>2015</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Systems/Databases | Versions | OS | Available with...
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>MS SQL Server</td>
<td>2000</td>
<td>Windows + Linux</td>
<td>All Talend products</td>
</tr>
<tr>
<td></td>
<td>2003</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2005</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2008</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2012</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MaxDB</td>
<td>7.6</td>
<td>N/A&lt;sup&gt;1&lt;/sup&gt;</td>
<td>Talend products with DI, MDM, ESB or Big Data</td>
</tr>
<tr>
<td>MongoDB</td>
<td>2.5.X</td>
<td>Windows + Linux</td>
<td>Talend products with Big Data</td>
</tr>
<tr>
<td></td>
<td>2.6.X</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3.0.X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MySQL</td>
<td>Mysql4</td>
<td>Windows + Linux</td>
<td>All Talend products</td>
</tr>
<tr>
<td></td>
<td>Mysql5</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>MariaDB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Netezza</td>
<td>7.2</td>
<td>Windows + Linux</td>
<td>All Talend products</td>
</tr>
<tr>
<td>Neo4j</td>
<td>1.X.X</td>
<td>Linux</td>
<td>Talend products with Big Data</td>
</tr>
<tr>
<td></td>
<td>2.X.X</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2.2.X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OleDb</td>
<td>2000</td>
<td>N/A&lt;sup&gt;1&lt;/sup&gt;</td>
<td>All Talend products</td>
</tr>
<tr>
<td></td>
<td>2003</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2005</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2007</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2010</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Oracle</td>
<td>Oracle 8i/9i/10g/11g/11g (11.6)/12c</td>
<td>Windows + Linux</td>
<td>All Talend products</td>
</tr>
<tr>
<td>ParAccel</td>
<td>3.1</td>
<td>N/A&lt;sup&gt;1&lt;/sup&gt;</td>
<td>Talend products with DI, MDM, ESB or Big Data</td>
</tr>
<tr>
<td></td>
<td>3.5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PostgreSQL</td>
<td>Prior to v9/v9.X</td>
<td>Windows + Linux</td>
<td>All Talend products</td>
</tr>
<tr>
<td>PostgresPlus</td>
<td>Prior to v9/v9.X</td>
<td>Windows + Linux</td>
<td>Talend products with DI, MDM, ESB or Big Data</td>
</tr>
<tr>
<td>Salesforce</td>
<td>V34 and earlier</td>
<td>Windows + Linux</td>
<td>All Talend products</td>
</tr>
<tr>
<td>SAP</td>
<td>4.6</td>
<td>Windows</td>
<td>All Talend products</td>
</tr>
<tr>
<td>SAP Hana</td>
<td>1.0</td>
<td>Windows</td>
<td>All Talend products</td>
</tr>
<tr>
<td>SQLite</td>
<td>3.6.7</td>
<td>Windows + Linux</td>
<td>All Talend products</td>
</tr>
<tr>
<td>Sybase</td>
<td>12.5</td>
<td>Windows + Linux</td>
<td>All Talend products</td>
</tr>
<tr>
<td></td>
<td>12.7</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>15.2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>15.5</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>15.7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SybaseIQ</td>
<td>12.5</td>
<td>Windows + Linux</td>
<td>All Talend products</td>
</tr>
<tr>
<td></td>
<td>12.7</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>15.2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Supported systems, databases and business applications by Talend components

<table>
<thead>
<tr>
<th>Systems/Databases</th>
<th>Versions</th>
<th>OS</th>
<th>Available with...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Teradata</td>
<td>12, 13, 14, 15</td>
<td>Windows + Linux</td>
<td>All <a href="#">Talend</a> products</td>
</tr>
<tr>
<td>VectorWise</td>
<td>2</td>
<td>Windows + Linux</td>
<td><a href="#">Talend</a> products with DI, MDM, ESB or Big Data</td>
</tr>
<tr>
<td>VtigerCRM</td>
<td>Vtiger 5.0, N/A&lt;sup&gt;1&lt;/sup&gt;, Vtiger 5.1</td>
<td>N/A&lt;sup&gt;1&lt;/sup&gt;</td>
<td>All <a href="#">Talend</a> products</td>
</tr>
<tr>
<td>Vertica</td>
<td>3, 3.5, 4, 4.1, 5.0, 5.1, 6.0, 6.1.X, 7.0.X</td>
<td>Windows + Linux</td>
<td><a href="#">Talend</a> products with DI, MDM, ESB or Big Data</td>
</tr>
</tbody>
</table>

<sup>1</sup> The test information is not available yet.

<sup>2</sup> When working with Java 8, only the General collation mode is supported.